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Federal Communications Commission

Radio Frequency Interference Statement

WARNING:  This equipment generates, uses, and can radiate radio frequency energy and if not
installed in accordance with the instruction manual, may cause interference to radio
communications.  It has been tested and found to comply with the limits for a Class A computing
device pursuant to Subpart J of Part 15 of FCC rules, which are designed to provide a reasonable pro-
tection against such interference when operated in a commercial environment.  Operation of this
equipment in a residential area is likely to cause interference in which case the user, at his own
expense, will be required to take whatever measures may be required to correct the interference.



Lead (Pb) Mercury (Hg) Cadmium (Cd)

Chromium VI 

Compounds

(Cr
6+

)

Polybrominated

Biphenyls

(PBB)

Polybrominated

Diphenyl Ethers 

(PBDE)

Optical Bench Assembly

Source Block Assembly

Detector Block Assembly

Ribbon Cable Assembly

ylbmessA elbaC laireS

LED Circuit Board Assembly

tiK elbaC 232-SR

Main Board V2 Circuit Board Assembly

gulP paC deR

 (Pb)  (Hg)  (Cd)  (Cr
6+

)  (PBB) (PBDE)

 RS-232 

 V2 

X: this component does contain this hazardous substance above the maximum concentration values in homogeneous materials 

specified in the SJ/T 11363-2006 Industry Standard (Company can explain the technical reasons for the "X")

Hazardous Substances or Elements

Component Name

LI-840A

O: this component does not contain this hazardous substance above the maximum concentration values in homogeneous materials 

specified in the SJ/T 11363-2006 Industry Standard.

X:  SJ/T 11363-2006 o ( ,

 "X" o )

LI-840A  CO2/H2O

O:  SJ/T 11363-2006 o

Doc. #53-13776-A

May 21, 2013  Page 1 of 1

X

X

X

O

X

O

O

X

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

X

X

X

O

X

O

O

X

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

LI-COR, inc. 
Environmental 
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Declaration of Conformity 
 

Manufacturer's Name:  LI-COR Inc. 
 
Manufacturer’s Address:  4647 Superior Street 

Lincoln, Nebraska USA 68504 
 

This declaration of conformity is issued under the sole responsibility of the manufacturer. 
 
Product Description: The LI-840A is a CO2 and H2O Gas Analyzer.   
 
Product Name:   Gas Analyzer 
Model Number(s):   LI-840A, LI-840-01, LI-840A-02 
Product Options:   None 
 
This product complies with the requirements of the EMC Directive 2004/108/EC, and the RoHS 
Directive 2011/65/EU, and carries the CE marking accordingly.    
 
Harmonized Standard Product Specifications: 
EMC: 
EN 55011 : 2009/A1:2010 Radiated Emissions, Class A  
EN 55011 : 2009/A1:2010 Conducted Emissions, Class A 

EN 61326-1:2006 Electrical equipment for measurement, control and laboratory use 
IEC 61000-4-2 : 2008 ESD, 4KV/8KV Contact/Air 
IEC 61000-4-3 : 2006/A1:2007/A2:2010 Radiated RF Immunity, 10V/m   
IEC 61000-4-4 : 2012  EFT/Burst 
IEC 61000-4-5 : 2005 Surge 
IEC 61000-4-6 : 2008 Conducted RF Immunity   
IEC 61000-4-8 : 2009 H-Field Immunity, 3A/m    
IEC 61000-4-11 : 2004 Voltage Dips 

FCC 47 CFR Part 15.109 Radiated Emissions, Class A 
FCC 47 CFR Part 15.107 Conducted Emissions, Class A 
 
Note:  
This document is serial number specific.   
Adherence to the EMC testing standards listed above is claimed for the non-OEM version of the LI-840A.  
EMC performance can be affected by the complete installation, therefore if using OEM versions (LI-840-
01 and LI-840A-02), the final equipment manufacturer should re-qualify the complete system to the EMC 
Directive.   

____________________________ 
Document #53-13759-A-       John Rada

Engineering Manager
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NOTICE

The information contained in this document is subject to change without notice. LI-CORMAKES NOWARRANTYOF ANY KINDWITH
REGARD TO THIS MATERIAL, INCLUDING, BUT NOT LIMITED TO THE IMPLIEDWARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. LI-COR shall not be liable for errors contained herein or for incidental or consequential damages
in connection with the furnishing, performance, or use of this material.

This document contains proprietary information which is protected by copyright. All rights are reserved. No part of this document may be
photocopied, reproduced, or translated to another language without prior written consent of LI-COR, Inc.

© Copyright 2010-2016, LI-COR, Inc.
Publication Number: 984-10690

Printing History
April 2010
January 2011
Updated May 2013; May 2015; June 2016

New editions of this manual will incorporate all material since the previous editions. Update packages may be used between editions which
contain replacement and additional pages to be merged into the manual by the user.

The manual printing date indicates its current edition.  The printing date changes when a new edition is printed. (Minor corrections and
updates which are incorporated at reprint do not cause the date to change).

LI-COR, Inc. • 4421 Superior Street • Lincoln, Nebraska  68504
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Toll-free: 1-800-447-3576 (U.S. & Canada)
e-mail: envsales@licor.com • www.licor.com



Table of Contents

Section 1. General Description

What's What 1-1
Features 1-3
Precautions 1-3
Getting Started Tutorial 1-4

Section 2. Power On

Alarms 2-1

Section 3. Operation

Installing the PC Communication Software on Your Computer 3-1
Setting the Communication Parameters 3-2
Cabling 3-2
RS-232 Output 3-2
Initial Setup 3-3

v



Using the Toolbar 3-6
Settings Window - Setting Operational Parameters 3-7

Enable Heater 3-8
Pressure Compensation 3-8
Filter 3-8
DAC Output 3-8
CO2 Span Range 3-13
Alarms 3-13

Using the Terminal Strip 3-14
Software Reference 3-16

Charting Window 3-16
Series 1 3-17
Series 2 3-17
X-Axis Max 3-17

Diagnostic Window 3-18
Logging Data 3-19

Start Logging 3-19
Stop Logging 3-20
Pause Logging 3-20
Options 3-21

Calibration Window - Setting the Zero and Span 3-23
Two Point Span (Span 2 Tab) 3-26



Considerations for performing a secondary span 3-28
Coefficients Page 3-29
Advanced Page 3-30

Connecting the LI-840A to the LI-1400 Datalogger 3-32

Section 4. Theory of Operation

System Overview 4-1
Optical Bench System 4-2

Section 5. Maintenance

Cleaning the Optical Bench 5-1
Changing the Fuse 5-5
Note on Infrared Source Replacement 5-6
Storing the LI-840A 5-7

Appendix A. Specifications



Appendix B. Equation Summary

Appendix C. Pin Assignments

Appendix D. Suppliers

Appendix E. Configuration Grammar

Element Descriptions E-15



Section 1. General Description

What's What
This procedure should be followed if you have just taken delivery of your LI-840A. Check the
packing list to verify that you have received everything that was ordered and that you have also
received the following items:

l RS-232 Cable - (Part #392-04993), used to connect the LI-840A to your computer. This cable
is a null modem (cross-over) type cable; a straight through type cable will not work with the
LI-840A. Appendix C shows the pin assignments for the DB-9 connector on the LI-840A front
panel. An RS-232-to-USB converter is provided as well (Part # 6400-27)

l Data Communications Software - This Windows® 7, 8/8.1, and 10 compatible software is
used for communication between the LI-840A and a computer. The software is provided on
CD. A complete description of this software can be found in Operation on page 3-1.
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l Standard Spare Parts Kit (9980-021) - This kit contains replacement parts for the LI-840A.
As you become familiar with the analyzer you will learn which items to keep close at hand
and which items can be stored away. The spare parts kit contains these items:

Description Qty. LI-COR Part No.

Spares Kit: 1 9980-021
Polyurethane Mounting Feet 4 234-02268
Mounting Screws 4 149-02610
Terminal Block 1 331-05273
Bev-a-line Tubing 12' 222-01824
Gelman Air Filter 2 9967-008
Quick Connect Unions 2 300-03123
Rapid Tube Fitting Nut 2 9861-036
2A Fuse 2 439-03952

Cleaning Kit: 1 9980-013
5" Cleaning Swabs 5 610-05315
O-Rings 4 192-00226
Pre-formed Optical Bench Tubing 4 6580-010

Section 1
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Features
The LI-840A is an economical, high performance, non-dispersive infrared gas analyzer designed
to be used for a wide variety of applications. Some of the LI-840A's important features include:

l A 14 cm (5.5") optical bench is used to obtain a CO2 measurement range of 0-20,000 ppm
(parts per million, or µmol/mol) and an H2O measurement range of 0-60 mmol/mol.

l The optical bench is fully serviceable by the user; cleaning the optical bench is a simple pro-
cess, and does not affect the instrument's factory calibration.

l Simple Windows® software provides for easy user calibration and data output.

Precautions

l Avoid storing the LI-840A in humid conditions while powered off. Doing so can cause the
optical sensor to become saturated with humidity, which will temporarily affect meas-
urements when the instrument is removed from storage. See Storing the LI-840A on page 5-7
for more details.

l The optical bench is maintained at a constant temperature of about 50 °C. Avoid direct expos-
ure to sunlight or extremely high temperatures that may elevate the temperature inside the
LI-840A case.

l The optical source is sensitive to vibration, and can be damaged by strong vibrations or jar-
ring. Do not drop the LI-840A or expose it to severe mechanical shock.

1-3Section 1. General Description
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l Do not use abrasive cleansers when cleaning the optical bench, as damage to the gold plating
may result. Instructions for cleaning the optical bench can be found in Section 5.

l Always filter air entering the LI-840A. Two Gelman filter assemblies (p/n 9967-008) are
included in the spares kit.

Getting Started Tutorial
The following section briefly covers the basic steps you might follow to set up the LI-840A to col-
lect and record data. Many of these steps are described in greater detail throughout this manual.

1 Install the PC Communications Software.
This software is used to set the zero and span of the LI-840A and set up data communication and
data transfer parameters for viewing and logging data. Installation instructions can be found in
Installing the PC Communication Software on Your Computer on page 3-1.

2 Determine your jumper settings for high and low alarm output, if required.
There are 2 jumpers inside the LI-840A case (on the main circuit board), which toggle the high
and low alarm output between 0-5V (TTL levels) and an open drain condition. The default
jumper positions are set for 0-5V output for both high and low alarms. This alarm configuration
is suitable for logic devices such as dataloggers. To use the high and/or low alarms to operate a
relay switch, the jumpers should be reconfigured for open drain output. See Alarms on page 2-1,
for a description of how to change the alarm jumper settings.

Section 1
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If the default jumper positions are suitable for your application, or if you do not intend to use
the alarms, proceed to Step 3.

3 Connect a power source to the LI-840A
The LI-840A requires an input voltage of 12-30 VDC. The power supply must be able to source a
maximum current drain of 1.2A (at 12 VDC). After the instrument has warmed up it will draw
about 0.3A (at 12 VDC) with the heaters on.

+ -

1 2 3 4 5 6 7 8 9 10 11 12 13 14 Bare wire leads are connected to the terminal strip at positions 1 and 2. Connect the positive lead
(usually red) to position #1 (12-30VDC), and the negative lead to position #2 (GND).

NOTE: Pull straight out on the face of the terminal strip to remove it; this can make it easier
to connect the wires.
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4 Connect the RS-232 cable.
Connect one end of the serial cable to the 9-pin Serial I/O port on the LI-840A front panel, and
the other end to a serial port on your computer. If you want to interface to a device with a 25-pin
serial port, a 9-pin to 25-pin adapter must be used; a gender changer may be required in some
cases. Tighten the two screws on the ends of the serial cable.

5 Connect other output device(s) if desired.
Output devices such as dataloggers and relay switches for high and low alarms are connected via
the terminal strip. A complete description of the terminals can be found in Section 3, Using the
Terminal Strip.

6 Connect an air pump and external power source.
The LI-840A sample cell must be continually flushed while making measurements, which
requires an external air pump that supplies a flow rate of between 0.25 and 1.0 liters per minute.
LI-COR offers a Diaphragm Pump under part number 286-04198 that is suitable for use with
the LI-840A. One pump plumbing option is shown below.

Section 1
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1/4" O.D. 

Bev-A-Line

Diaphragm

Pump

Quick Connect

Sample Air

Exhaust

Quick Connect

with Regulator
Quick Connect ‘Y’

Quick Connect ‘L’

Flow Meter

(set to 1 LPM)

IN

LI-840/A

Filter - Gelman

or Balston

µPart # 9967-008        
    

 IN
  
  

  
  
  
   

   
  1

µm PTFE               IN    

NOTE: More information about plumbing options and parts available from LI-COR can be
found in Application Note #IRG4-105, entitled ‘Air Pumps and Accessories for LI-COR Gas Ana-
lyzers - Suggested Parts and Vendors’, which can be downloaded from www.licor.-
com/env/support.
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7 Connect the input air stream and external filter.
Remove the nut from the FLOW IN fitting and conect a short (12" or so) piece of Bev-a-line
tubing (from the spares kit) . Tighten the nut. Place a Geman filter (also from the spares kit) in
the sample airstream before it enters the FLOW IN port on the LI-840A. A user-supplied pump is
required to force air through the LI-840A.

IMPORTANT: Always install the external air filter before operating the LI-840A. Insert filter
into the input airstream before it enters the LI-840A. Failure to do this will lead to con-
tamination of the optical path.

 

μ
P

art # 9967-008

I
N

1μ
mPTFE

IN

Air In

Air Out

When using the LI-840A for applications where sample air is particularly dirty, you may con-
sider stacking two filters in series. For maintenance, replace the filter furthest upstream from the
analyzer with the filter closest to the analyzer and replace the filter closest to the analyzer with a
new filter.
Install the new filter(s) with the blue lettering facing away from the FLOW IN port.
The air inlet and outlet ports should be covered with the dust caps provided or attached to an air
line when the instrument is not in use. This will prevent dust from entering the instrument
downstream from the filters where it can enter the optical path.
Replacement Gelman Acro 50 filters can be obtained from LI-COR (part #9967-008).

Section 1
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8 Start the PC Communications Software.
Click on the program icon to start the application. The Main window appears. Select Connect
from the File menu. Choose the serial port to which the LI-840A is connected, and the data out-
put interval. Click the Connect button. If the analyzer is connected properly, data will appear in
the main window.

9 Configure the analyzer.
Select Settings from the View menu. The Settings window appears. Choose a value for signal
averaging (the Filter field), between 0 and 20 seconds. Set values for high and low alarms and
corresponding dead bands, if desired. See Alarms on page 2-1 for a complete description of the
alarms. If you are using an output device to collect data, choose the value to be output at DAC 1
and/or DAC 2. Make sure the Enable Heater and Pressure Compensation buttons are enabled
(checked), and click OK.
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10 Set the analyzer zero.

NOTE: The LI-840A is calibrated at the factory before shipping. It is recommended, however,
that you verify the calibration by connecting a gas with known concentration and reading the
displayed value. If the instrument needs to be calibrated, follow the steps below.

Connect a dry, CO2-free gas to the input air stream. Select Calibration from the View menu.
Click on the Zero tab. Click the Zero CO2. Wait up to 15 minutes for any water vapor to clear
from the optical cell, then click the Zero H2O button. After several seconds, a message will
appear that indicates the IRGA is zeroed.

Section 1
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11 Set the analyzer span.
Connect a span gas with known concentration of CO2 to the input air stream. Choose a span
gas that will be below or close to the highest reading expected. Select the Span tab. Enter the
value of the span gas in ppm. Click on Span CO2. A message will appear indicating when the
span calibration is completed.
Connect an airstream with a known water vapor concentration (such as may be generated by the
LI-610 Portable Dew Point Generator). Enter the dew point value of the H2O span gas, in
degrees C, and click on Span H2O.
Connect a second span gas with a known concentration of CO2 to the input air stream. If the
reading is not within 1% of the expected value, perform a second span: use a span gas with a con-
centration that is higher than the highest expected reading. Under the Span 2 tab enter the 2nd
span gas concentration and click Span CO2.
Check the H2O reading with a water vapor concentration that is higher than that used to set the
H2O span. If the reading is outside the acceptable range, perform a secondary H2O span. Click
Close.
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12 Set up the logging parameters.
Select Options from the Logging menu. Choose the File Header(s) to be output with the data,
the values to be logged, the field delimiter, and log frequency. Click OK. Choose Start from the
Logging menu. Enter a file name for the data file. Click Save.

13 Set up the charting parameters, if desired.
Select Charting from the View menu. Enter the value to be plotted, the Y-Axis min and max val-
ues, X-Axis max, and time units to be displayed on each plot. Click Start to begin recording data.
Graphs with data will appear in the window and data will be logged to the file designated in
Step 11 above.

14 Choose Stop from the Loggingmenu to stop recordingwhen you are done collecting data.

Section 1
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Section 2. Power On

The LI-840A can be connected to a constant source of AC power using a transformer that
provides 12-30VDC (14 watt maximum) to the LI-840A. If the LI-840A is powered with a voltage
below 10.5 volts, the analyzer will not power up, and the Low Battery LED on the top panel will
illuminate. The LI-840A will continue to operate with a low battery; there will, however, be a cor-
responding reduction in performance.

Alarms
The LI-840A is equipped with high and low alarms, which can be configured as open collector
or 0-5V output (TTL levels) using jumpers on the main PC board ( above). The default con-
figuration is 0-5V output. Figure 2-2 on page 2-3 shows the position of the jumpers for each of
the two alarm conditions.

Note: The alarms can be used for either CO2 or H2O concentrations; only one can be chosen
at a time, however.
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Figure 2-1. Location of alarm jumpers LK1 and LK2.
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Figure 2-2. Position of jumpers for open drain and 0-5V output.
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In addition, a "dead band" value can be set in software for both high and low alarms. To under-
stand how the alarms and dead band values work, look at the diagram below.
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In this chart, the low and high alarm values are set to 100 ppm and 1000 ppm, respectively. The
dead band value in both alarms is set to 100 ppm. When the CO2 concentration reaches 1000
ppm, the high alarm is activated, and remains active until the concentration drops below 900
ppm. When the CO2 concentration falls below 100 ppm, the low alarm is activated, and remains
active until the concentration rises above 200 ppm. Your choice for the dead band value(s)
depends on your application and the fluctuation in CO2 concentrations over time.
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Note: Increasing the signal average value in software (see Settings Window; Options; Filter in
Section 3) can help reduce fluctuations in readings.

Alarm LEDs can be viewed on the top panel of the LI-840A. Terminals 3 and 5 on the terminal
strip are also connected to the High and Low alarms, respectively. This is useful for connecting
an audible alarm, for example, or a relay switch to operate another device that will raise or lower
the CO2 concentration to the desired level. The schematic diagram below shows how the high
alarm could be connected to a relay switch that triggers an exhaust fan in a greenhouse envir-
onment. These relays could also be used to trigger devices such as automatic dialers, alarms,
pumps, and valves in industrial and other environments.
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Air Inlet

12VDC

+ -

Mains

120VAC

1 2 3

V
+

G
N

D
H

ig
h

 a
la

rm

Fan

Exhaust

Fan

A list of suppliers of electronic relay switches can be found in Appendix D.

NOTE: Consult your local electrical codes before wiring, and/or have a professional elec-
trician wire your application.

Section 2
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Section 3. Operation

This section describes basic operation of the LI-840A.

Installing the PC Communication Software on Your Computer
The software application is shipped on CD. It requires that your computer have an RS-232 serial
(COM) interface, and Windows® 7, 8, 8.1, or 10.

618-10787

Application Software V2.0.0 Run Setup.exe

®

LI-840A
CO2 /H2O GAS ANALYZER

An installation menu will start when you insert the CD into your CD-ROM drive. Select Install
Software from the menu and follow the instructions. If installation does not start, select Run from
the Windows Start menu, and select the LI840Setup.exe file on the CD. When the software has
finished the installation procedure, a program icon will be placed in the Programs menu.

NOTE: To remove the software, go to the Control Panel and select Add/Remove Programs (XP)
or Uninstall a program (Vista/7). Choose LI840 from the list of programs and click the Add/Re-
move button. If your computer has the older LI840 software, be sure to use the correct pro-
gram when configuring the LI-840A.
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Setting the Communication Parameters
LI-840A communication parameters are set automatically when the program is run.

Cabling
The serial cable (null modem) included has 9-pin connectors on both ends; either end plugs
into the 9-pin connector (Serial I/O) on the front panel of the LI-840A. Use this cable to inter-
face with your computer's 9-pin serial port. If you want to interface to a computer with a 25-pin
serial port, a 9-pin to 25-pin adapter must be used. To connect to a computer with a USB port, a
9-pin serial to USB adapter must be used.

RS-232 Output
Data from the LI-840A can be transferred to a computer for analysis, printing or storage using
the RS-232 interface. The LI-840A RS-232 port is configured as Data Terminal Equipment (DTE)
with no hardware handshaking, and is bi-directional, meaning information can be transferred
both into and out of the LI-840A.

The application software that comes with the LI-840A is used to view data and configure the LI-
840A from a PC.

Section 3
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Initial Setup
Click on the LI-840A program icon to start the program. The LI-840A Main Window appears.
Select Connect from the File menu, or click on the connect icon on the toolbar, beneath the File
menu. You are asked to select the serial port to which the LI-840A is connected, and the output
interval at which data are output (0.5 to 20 seconds, in 0.5 second increments).

Choose a COM port and the output interval and click Connect. If the instrument is connected
properly, data will begin to appear in the Main window (below):
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The Main Window displays the CO2 concentration (ppm) and H2O concentration (°C or mmol/-
mol), cell temperature and pressure, and the status of various LI-840A parameters. There are also
three menus used to configure the LI-840A, perform zero and span calibrations, and set up the
parameters for recording data.

Section 3
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Note that you can view H2O concentrations in units of degrees C or mmol/mol. To change the
units in the Main window, go to the View menu and toggle the H2O in ppt menu item on and
off. Alternatively, you can click on the H2O units being displayed in the Main window to change
the display.

The LI-840A parameters displayed in the Main window are as follows:

Parameter Description
Cell Temperature Temperature (°C) in the LI-840A optical cell. This value should

remain near 50 °C when the heater is turned ON.
Cell Pressure Barometric pressure (kPa) measured in the LI-840A optical cell. This

value can be used to correct measurements for the effects of atmo-
spheric pressure.

Output Rate Displays data output rate chosen at connection.
Heater Shows status of heater (ON/OFF), which is used to maintain the

optical cell at a constant 50 °C. The heater is turned ON/OFF in the
Settings window.

Pressure Comp. Shows whether pressure compensation is ON/OFF. When ON, meas-
urements are corrected for the effects of pressure fluctuations on gas
density and band broadening.

Alarms Shows status of High and Low alarms, whose values are set in the Set-
tings window. Alarms are enabled (ON), or disabled (OFF).
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Parameter Description
Filter Shows the current value for software signal averaging, set in the Set-

tings window. The filter can be set from 0 (no signal averaging) to 20
seconds.

DAC Output Displays source channels for DAC1 and DAC2, and the voltage out-
put range (0-2.5V or 0-5V).

PC Logging Shows "Off" if data are not being logged to a file, or "Logging" when
data are being logged to a file.

Using the Toolbar

The toolbar in the Main window contains shortcuts for some of the commonly used menu
items:

Section 3
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Settings Window - Setting Operational Parameters

The Settings window contains parameters related to initial setup of the LI-840A, including signal
filtering, high and low alarm setup, heater and pressure compensation options, and DAC output
sources. Choose Settings from the View menu (or click on the toolbar icon) to open the Settings
window:
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Enable Heater

The Heater should be enabled to maintain the optical bench at a constant 50 °C.

Pressure Compensation

Enable the Pressure Compensation check box to automatically correct gas concentration values
for changes in cell pressure. In most cases this should be turned on; disabling this feature means
that no pressure correction is desired in the gas concentration calculations, which can lead to
erroneous measurements.

Filter

Shows the current value for software signal averaging. The filter can be set from 0 (no signal
averaging) to 20 seconds. Note that increasing the filter decreases instrument noise but reduces
the response time.

DAC Output

Analyzer output for up to 2 values (none, CO2, H2O mmol/mol, H2O °C, Cell Temperature, or
Cell Pressure) can be recorded by connecting a logging device to the terminal strip on the front
of the analyzer. Output is linear, and is selectable at 0-5V or 0-2.5V. Choose the full-scale voltage
output range and the source for DAC 1 and/or DAC 2. You can also choose a range over which
to scale the output(s); you can achieve better resolution by scaling the output(s) over a narrower
range when appropriate.
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The DACs in the LI-840A are bipolar, and will go slightly negative (~-0.100V). This can happen,
for example, if the cell becomes contaminated or from small random perturbations when the
CO2 concentration is near zero. See Cleaning the Optical Bench on page 5-1 for instructions on
cleaning the cell should it become contaminated.

Voltage output is measured by attaching the positive lead from the logging device to terminal 9
(V Out 1), or terminal 7 (V Out 2) on the LI-840A terminal strip. Connect the negative lead to
position 10 (GND), or position 8 (GND).

The CO2 or H2O concentration can be calculated from the DAC output voltage as follows:

3-1

where V is the measured voltage, XF is the full scale value for CO2 or H2O output (entered in
the Settings Window as the 2.5 or 5 V value, up to 20,000 ppm for CO2), XZ is the zero value
entered, and Vmax is the full scale DAC output voltage selected (5V or 2.5V).

Example: The DAC output range selected is 0-5V (Vmax), the zero CO2 value entered is 0 ppm
(XZ), the full scale CO2 value entered is 2000 ppm (XF), and the measured output voltage (V) is
2.9V. To calculate the CO2 concentration from 3-1 above,

3-2

= 1160 ppm.
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Example: The DAC output range selected is 0-5V (Vmax), the zero CO2 value entered is 1000
ppm (XZ), the full scale CO2 value entered is 2000 ppm (XF), and the measured output voltage
(V) is 2.9V. To calculate the CO2 concentration from 3-1 above,

3-3

= 1580 ppm.

The H2O concentration (mmol/mol) can be calculated from the DAC output voltage as follows:

3-4

where V is the measured voltage, XF is the full scale value for H2O output (entered in the Set-
tings Window as the 2.5 or 5V value, up to 60 parts per thousand), XZ is the zero value entered,
and Vmax is the full scale DAC output voltage selected (5V or 2.5V).

Example: The DAC output range selected is 0-5V (Vmax), the zero H2O value entered is 0 ppm
(XZ), the full scale H2O value entered is 60 mmol/mol (XF), and the measured output voltage
(V) is 2.9V. To calculate the H2O concentration from equation 3-4 above,

3-5

= 34.8 mmol/mol.
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Example: The DAC output range selected is 0-5V (Vmax), the zero H2O value entered is 10
mmol/mol (XZ), the full scale H2O value entered is 60 mmol/mol (XF), and the measured out-
put voltage (V) is 2.9V. To calculate the H2O concentration from equation 3-4 above,

3-6

= 39.0 mmol/mol.

Converting Voltage Output to Cell Temperature

Cell temperature can be calculated from the DAC output voltage as follows:

3-7

where V is the measured voltage, XF is the full scale value for temperature output (entered in the
Settings Window as the 2.5 or 5V value, up to 100 °C), XZ is the zero value entered, and Vmax is
the full scale DAC output voltage selected (5V or 2.5V).

Converting Voltage Output to Cell Pressure

Cell pressure can be calculated from the DAC output voltage as follows:

3-8
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where V is the measured voltage, XF is the full scale value for cell pressure output (entered in the
Settings Window as the 2.5 or 5V value, up to 115 kPa), XZ is the zero value entered, and Vmax
is the full scale DAC output voltage selected (5V or 2.5V).

Converting Current Output to ppm CO2 or mmol/mol H2O

Current output can be measured by connecting the positive input of the data logging device to
positions 11 or 13 (4-20 mA 2 or 4-20 mA 1), and the negative input to position 12 or 14
(GND). The current output at positions 11 and 13 is non-isolated, and is rated to drive a 250
ohm load.

Note: These channels mirror their respective voltage output channels; current output channel
1 uses the variable chosen for voltage output 1, and current output channel 2 uses the vari-
able chosen for voltage output 2. Similarly, a voltage output of 0 volts corresponds to a cur-
rent output of 4 mA, and when the voltage outputs are at full scale (2.5 or 5 V), the current
output will be 20 mA.

To convert current output (I) to CO2 or H2O concentration in your computer or other output
device, the following equation can be used:

3-9
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where I is the measured current, XF is the full scale value for CO2 or H2O concentration output
(entered in the Settings Window as the 2.5 or 5V full scale value, up to 20,000 ppm for CO2),
and XZ is the zero value entered.

Example: The zero CO2 value entered is 0 ppm (XZ), the full scale CO2 value entered is 2000
ppm (XF), and the measured current output (I) is 16.25 mA. To convert to ppm CO2:

3-10

= 1531.25 ppm.

CO2 Span Range

The span range entry field determines the maximum CO2 range over which the LI-840A will
make measurements. The factory calibration range for the LI-840A is 0-20,000 ppm. Note that
there is a benefit to selecting a narrower range if that range is adequate for your experiment. The
narrower range provides better resolution in terms of the digital-to-analog converter (DAC). For
example, if you choose a range of 0-1500 ppm, each step of the DAC is able to resolve twice as
many data points as compared to the 0-3000 ppm range, which results in better resolution.

Alarms

Allows you to enable/disable the alarms, and enter high, low, and dead band values. A complete
discussion can be found in Alarms on page 2-1.

3-13Section 3. Operation

Section 3



Using the Terminal Strip

The terminal strip is located on the front panel of the LI-840A. To connect the wires, insert the
bare wire end into the appropriate terminal and tighten the screw above that terminal using the
small flat head screwdriver in the spare parts kit. The front face of the terminal strip can be
removed to aid in connecting the wires by pulling straight out on the face.

1 2 3 4 5 6 7 8 9 10 11 12 13 14 The terminal positions are as follows, reading from left to right:

Terminal Label Description
1 12-30 VDC Voltage In, 12-30 VDC
2 GND Ground
3 High Alarm High Alarm
4 GND Ground
5 Low Alarm Low Alarm
6 GND Ground
7 V OUT 2 Voltage output channel 2
8 GND Ground
9 V OUT 1 Voltage output channel 1
10 GND Ground
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Terminal Label Description
11 4-20 mA 2 Current output channel 2
12 GND Ground
13 4-20 mA 1 Current output channel 1
14 GND Ground
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Software Reference

Charting Window

Select Charting from the View menu to open the Charting window (below). This is the window
in which you can set up the parameters for plotting your data. Two charts can be plotted sim-
ultaneously, using Y axes on either side of the chart.
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Series 1

The Series 1 options are used to plot a chart with the Y axis on the left side of the chart. Choose
the value to be logged and set the maximum and minimum values for the Y axis.

Series 2

The Series 2 options are used to plot a chart with the Y axis on the right side of the chart.
Choose the value to be logged and set the maximum and minimum values for the Y axis.

X-Axis Max

Sets the maximum value for the X axis (Time). The units for the X axis can be seconds or
minutes.

Press Start at any time to view the chart layout and begin displaying data. Note that you must
press Stop to make changes to the chart parameters, and then press Start again to resume data
display.
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Diagnostic Window

Select Diagnostics from the View menu to open the Diagnostics window (below). This window
displays the current LI-840A internal software version number, the input voltage, and raw absorp-
tion values.
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Logging Data

Start Logging

Opens the Log File Destination dialog, where you enter a file name for the data file. The file
extension .txt is added automatically.
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Stop Logging

Stops data logging.

Pause Logging

Pauses logging of data until Start is chosen from the Logging menu again, or the Start button
on the toolbar is pressed.
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Options

Opens the Logging Options window, where you can configure the data output options.
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As configured above, the data output would appear similar to that shown below.
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Calibration Window - Setting the Zero and Span
Select Calibration from the View menu to open the Calibration window. This is the area in
which you set the zero and spans of the LI-840A.
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It is recommended that you perform the zero calibrations first, followed by the span calibrations.
To zero, flow a dry, CO2-free gas through the LI-840A and make sure the optical cell is com-
pletely purged. Press the Zero CO2 button under the Zero tab.

The display will show ZERO, and the text in the Calibration window is grayed out. The zero will
be set electronically, and the current date will be entered in the "Last CO2 zero performed on:"
field when completed. Repeat for the H2O channel. Note: Purge the cell with the H2O zero gas for
up to 15 minutes before zeroing H2O. Water vapor molecules are “sticky” and it may take up to 15
minutes to reach equilibrium in the optical cell.
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To span, connect a span gas of known CO2 concentration to the input air stream. Make sure the
cell is purged. Under the Span tab, enter the value of the span gas and click on Span CO2.

The display will show SPAN, for several seconds and the text in the Calibration window will be
greyed out. The span will be set electronically, and the current date will be entered in the "Last
CO2 span performed on:" field when completed. Note: Ensure that the CO2 standards are accurate,
as this will determine the overall accuracy of the LI-840A.
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Repeat for the H2O channel using an airstream of known dew point. Note: Purge the cell with the
H2O span gas for up to 15 minutes before spanning H2O. The LI-610 Portable Dew Point Generator is
capable of providing an airstream with a known water vapor concentration.

Two Point Span (Span 2 Tab)

Suppose you have two non-zero calibration gasses (e.g. CO2 at 300 ppm and 1500 ppm), and you
use one of them (say, 1500 ppm) to set the span. If you then flow the other gas through the LI-
840A, you would expect it to read within 1% of the expected value (in our example, 300 ±3
ppm). If it does not, you can adjust the calibration for this by performing a Secondary Span, by
entering the span gas concentration and clicking the Span CO2 (Span 2 tab). After that, the 300
ppm tank should read 300, and the 1500 tank should still read 1500. This can also be performed
with H2O if needed.
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In the LI-840A version 2.0 and above, the span value is a linear function of absorptance, and
thus has two parameters, a slope and an offset (see Equation Summary on page B-1). Normal span
setting adjusts the offset and leaves the slope alone. Setting the secondary span adjusts the slope,
then adjusts the offset value for the new slope value. The slope and offset values can be viewed
on the Advanced page. Span offset values (CO2 Span and H2O Span) are typically 1.0 ±0.1). Span
slope values (CO2 Span 2 and H2O Span 2) are typically 0 ±0.1). When they are exactly 0, then
slope is a constant, and not a function of absorptance.
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The CO2 span slope value is first determined at the factory by setting the span at 200 ppm, and
doing an secondary span close to 20000 ppm. This value should remain valid for some time.
Things that are likely to make it change include changing the source and/or changing the
detector, a dirty optical cell, and possibly even taking the optical bench apart for cleaning.

Considerations for performing a secondary span

l Zero first.
l After zeroing, do a (normal) span.
l The span and secondary span concentrations should be as far apart as possible and they should bracket the con-

centration range of interest to you. (e.g. 200 and 20000, or 300 and 1500, etc.). “Far apart” means in absorptance, not
concentration. We recommend absorptance differences of at least 0.1 when choosing concentrations for setting span
and secondary span.
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For CO2, The difference in absorptance between 200 and 1000 ppm is typically about 0.1. There
is also a 0.1 absorptance difference between 3500 and 7000 ppm, and between 15,000 ppm and
40,000 ppm. For H2O, it is a little harder to get a 0.1 absorptance difference. If you want to do a
secondary span at room temperature, for example, the two span values would have to be 5 °C or
less, and 22 °C, for example.

0

0.1

0.2

0.3

0.4

-30 -20 -10 0 10 20 30 40

H
2
O

 A
b

s
o

rp
ta

n
c

e

Dew Point Temp (C)

Typical LI-840A

0.1

You can do multiple secondary spans after a normal span. For example, span at 200, then do a
secondary span at 3000. Then (assuming you didn’t like the result for some reason), you can do
another secondary span at 2000 ppm. As long as the secondary span is well away (in
absorptance) from the previous normal span, it is OK to do as many consecutive secondary spans
at various concentrations as you’d like.

Coefficients Page

The LI-840A uses a double rectangular hyperbola for the CO2 calibration, and a third order poly-
nomial for H2O calibration. The Coefficients page displays these factory-determined calibration
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coefficients, as well as those for band broadening and cross sensitivity, and coefficients for the
internal pressure transducer. These coefficients are fixed at the factory.

The calibration coefficients are unique to each instrument, and may be found on the calibration
sheet shipped from the factory. In most cases you will not want to alter any of these values.

A description of the band broadening can be found in Appendix B, Equation Summary.

Advanced Page

The calibration constants for CO2 and H2O zero and span calibrations are found on the
Advanced calibration page. These constants are stored to a file on the computer by clicking on
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Save to Defaults. Click Load Defaults to restore the values in this window using the file on the
PC. If new constants are entered in this window, click Send Constants to send the values to the
LI-840A for implementation.

In most cases you should not change the values in this window; see Symbol Summary on page B-
11 for a description of the terms used in this window.
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Connecting the LI-840A to the LI-1400 Datalogger

tcF

ffO/nO

puteS retnE

7

4

1

0

98

65

2 3

csE

XEE

weiV

tfihS

PM

T

ZYX

VU

RQ

ON

J

S

W

I

L

HG

K

C

F

B

E

A

D

The following example shows how you can connect the LI-840A to a datalogging device such as
the LI-COR Model LI-1400 DataLogger to collect analog data and convert to meaningful CO2
and/or H2O values. As mentioned earlier, voltage output from the LI-840A is linear; converting
analog data into ppm CO2 or mmol/mol H2O simply requires multiplying the raw mV output
by a conversion factor, which is dependent upon the selected voltage output range, and the max-
imum CO2 or H2O resolution available (set in software between 0-20,000 ppm). In general, the
conversion takes the form:

3-11

where V is the measured voltage, XF is the full scale value for CO2 or H2O output (entered in
the Settings Window as the 2.5 or 5V value, up to 20,000 ppm for CO2), XZ is the zero value
entered, and Vmax is the full scale DAC output voltage selected (5V or 2.5V). 

For example, if the voltage output is set for 0-5V (Vmax), the zero CO2 value entered is 0 ppm
(XZ) and scaled CO2 range is 2000 ppm (XF), and the measured voltage output is 2.9V, the equa-
tion would take the form:

3-12

= 1160 ppm.
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This general equation can be converted into simple multipliers, based on the two available
voltage output ranges and the CO2 (maximum 20,000 ppm) or H2O (maximum 100% RH)
range. These can be any value, depending on what is chose for the 0V and the full scale 2.5V
and 5V DAC output values. Each multiplier can then be entered in the data logging device to
convert raw voltage to CO2 or H2O values. Table 3-1 below lists some examples of values for this
multiplier; simply choose your DAC output range in the second row, and then select the LI-
840A CO2 range in the first column (the full scale value minus the zero value); follow across to
find the appropriate multiplier. Note that this table assumes that the zero value (XZ) is zero; if it
is not zero, the offset will need to be added onto the final result.

DAC Output Range
0-5V 0-2.5V

XF - XZ Multiplier (ppm/Volts)
1000 ppm 200 400
2000 ppm 400 800
5000 ppm 1000 2000
20000 ppm 4000 8000

Table 3-1. Multipliers for converting voltage output to CO2 readings (no offset).
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To calculate multipliers:

3-13

where XF is the full scale value for CO2 or H2O output, XZ is the zero or offset value entered,
and Vmax is the full scale DAC output voltage selected (5V or 2.5V).

The LI-1400 can be used to monitor voltage signals up to 2.5 volts with 76 microvolt resolution
in real time and convert them into meaningful engineering units shown on the display. Altern-
atively, the LI-1400 can be configured to automatically log these data over extended periods of
time and later transfer the results to a computer for further analysis.

Access to the voltage channels requires the 1400-301 Terminal block. Voltage channels are des-
ignated by the letter “V” and sequentially numbered V1-4. The lead from LI-840A terminal #7 or
#9 should be attached to one of the LI-1400 terminals labeled V1, V2, V3, or V4, while the lead
from terminal #8 or #10 should be attached to one of the LI-1400 terminals labeled ↓(ground).
See the LI-1400 manual for further details.

The following example shows how you can set up the LI-1400 Datalogger to collect raw voltage
output from the LI-840A and convert to CO2 values.
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1 Set the voltage output of the LI-840A for 2.5V output and specify the zero andmaximum values
for CO2 as described in DAC Output on page 3-8.

2 In the LI-1400, configure V1 channel as General for CO2.

3 Enter a description, such as CO2.

4 SetMath = Poly(nomial) and press Ent(er).

5 Set description as desired, a0 = the offset (for scaledmeasurements), a1 = multiplier from Table
3-1 on page 3-33 (or equation 3-13), and a2-a5 = 0. When finished, press Esc to return to the
main configuration list.

6 SetOper(ator) = none.

7 Enter a Label such as ppm for the units.

8 SetAverage=1 sec or as desired. CO2will now be displayed on channel V1.
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To log CO2 automatically:

1 Set Log Routine to the desired log routine.

2 Set Calc=Mean.

3 To capture the minimum andmaximum CO2 values, setMinMax accordingly.

4 TCoef has no effect when Calc=Mean. It is used only when integrating.
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Section 4. Theory of Operation

System Overview
The LI-840A CO2/H2O Gas Analyzer is an absolute, non-dispersive, infrared (NDIR) gas analyzer
based upon a single path, dual wavelength, infrared detection system. The CO2 and H2O meas-
urements are a function of the absorption of IR energy as it travels through the optical path.
Concentration measurements are based on the difference ratio in the IR absorption between a
reference and sample signal. Reference and sample channels measure infrared gas absorption in
a single path through the use of narrow band optical filters with appropriately selected bands.
The CO2 sample channel uses an optical filter centered at 4.26 micrometers, corresponding to
an absorption band for CO2. The reference channel for CO2 has an optical filter centered at 3.95
micrometers, which has no absorption due to CO2. The H2O sample channel uses an optical fil-
ter centered at 2.595 micrometers, corresponding to an absorption band of H2O. The reference
channel for H2O has an optical filter centered at 2.35 micrometers, which is a non-absorbing
region for H2O.
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The instrument uses digital signal processing techniques to determine the temperature and pres-
sure corrected CO2 concentration based on the optical bench signals using a ratiometric com-
putation. The data are passed through a double rectangular hyperbola (CO2) or 3rd order
polynomial (H2O) that performs linearization of the detector signal to a mole fraction in air
given in µmol CO2 per mole of air (ppm), and mmol H2O per mole of air (mmol/mol).

Data output is provided in a digital format through an RS-232 interface that supports connection
to an external computer. The instrument comes with Windows®-compatible software for instru-
ment configuration, control, data collection and display. Analog signals are available through a
terminal block for collection by a data logger or similar means.

Optical Bench System
The LI-840A CO2/H2O Gas Analyzer optical path is a thermostatically controlled IR detection
system. The optical bench operation is based upon a broad band IR source and a pyroelectric
detector. The source is mounted in a parabolic reflector to collimate the light and increase
energy throughput down the optical path to the detector. The reflector and optical path are gold
plated to further increase energy transmission. The detectors are pyroelectric devices that operate
based on thermal energy received. The narrow band optical filters allow only the wavebands of
interest to illuminate the detector, allowing for the determination of CO2 and H2O con-
centrations in the presence of other infrared absorbing gases.
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The detectors respond to thermal energy, so it is necessary to precisely regulate the detectors’ tem-
perature. This allows for differentiation of thermal gradient noise from the received signals from
the optical path. The detection system is shown in Figure 4-1 below.

Ribbon Cable

Connector

Gold Plated

Optical Path

Gold Plated

Parabolic Reflector

Source Detector

Broad Band IR Source

CO2 Filters

3.95 & 4.26 µm

H2O Filters

2.35 & 2.59 µm

Pressure Transducer

Heating Element Heating Element

Gas Inlet Gas Outlet

Thermistor Thermistor

Figure 4-1. Schematic diagram of the LI-840A optical bench.
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The optical bench has a thermostat that maintains a constant operating temperature of 50 °C. A
feedback loop is used to regulate the optical bench temperature. As shown in Figure 4-1, two
thermistors, located in the source and detector housings, measure the present temperature. The
thermistors are monitored as part of the control loop to determine corrections necessary in the
thermal balance. Two heating elements are the sources of thermal energy into the source and
detector housing. The optical path is in mechanical contact with the source and detector hous-
ing and thereby achieves thermal equilibrium.

The bench requires approximately 10 minutes to achieve the specified thermal temperature. A
longer period of approximately 20 minutes is required to bring the performance of the detection
system to within 1 to 2% of reading. As shown in Figure 4-1 on the previous page, the detector
housing has a pressure transducer integrated into the housing design. Part of the CO2 con-
centration calculation depends on the pressure observed in the optical path, measured with an
in-line pressure transducer. Many parameters can affect the pressure and thus the concentration
reading. The processing center in the analyzer reads the pressure reading as part of its data col-
lection task and uses this information in the concentration calculation. The gas flow enters the
source housing, passes down the optical path and exits at the detector housing. The maximum
flow rate for the analyzer is approximately 1 liter/min.
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Another key parameter in the concentration calculation is the gas temperature in the optical
path. It is assumed in the analyzer operation that the gas temperature will equilibrate to the
optical bench temperature (50 °C) by the time it enters the optical path. Since the instrument
performs temperature and pressure corrections as part of the concentration calculation, this
assumption is very important. To cause the sample air to equilibrate to the optical bench tem-
perature, an airflow pattern is created with sufficient eddy currents to cause thermal equi-
libration.

The optical bench is mounted in a foam enclosure to accomplish two purposes. The first is to
assist in maintaining the controlled thermal environment required for the optical bench as
described above. The second function of the foam enclosure is to protect the optical bench from
mechanical shock and vibration that might damage the mechanically sensitive components. The
foam enclosure is supported by a optical bench “tray” which is in turn attached to the main cir-
cuit board (PCB). The optical bench is mechanically de-coupled from the case by creating the s-
bend in the Bev-a-line tubing from the external fittings to the optical bench gas inlet and outlet
connectors. The electronic interface to the source and detector is achieved through printed cir-
cuit boards mounted directly to the source and detector housings, respectively. The PCBs con-
nect the main PCB to the source and detector PCBs via a ribbon cable. This achieves the
mechanical isolation desired for the optical bench.

A 14 cm (5.5") optical bench provides a CO2 measurement range of 0 – 20,000 µmol/mol
(ppm), and an H2O measurement range of 0 – 60 mmol/mol.
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Section 5. Maintenance

Cleaning the Optical Bench
The LI-840A optical bench can be removed and cleaned if necessary. If the optical path becomes
dirty it may become difficult to span the analyzer. Excessive zero drift may also be observed if the
optical path becomes dirty. Follow these steps to clean the optical bench:

1 Turn the LI-840A off.
Remove the six screws on the LI-840A top panel and remove the cover. Note that these screws
are not molded into the case and may fall out.

2 Unscrew the tube retaining nuts on the inner air port fittings.
Remove the tubing from both air ports. Leave the tubing connected to the source and detector
housings.
There are ribbon cables connected to the circuit boards on the source and detector housings, as
shown below. Pull straight out on the connector that is attached to each ribbon cable. The
optical bench can now be removed from the foam casing.
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There are four screws on the source and detector circuit boards that must be removed.
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3 Remove the four screws in the corners of the boards.
Do not remove the four small screws.

 

Remove these 

4 screws

The source and detector housings (with attached circuit boards) can now be removed. The
bench will appear as shown below. It is a good practice to replace the O-rings when cleaning or
replacing the optical path.

 

O-ring

Top View

End View

There are a number of swabs in the spare parts kit. Dip one end of the swab into a 50:50 eth-
anol/water solution and carefully swab both ends of the optical bench, until there is no more vis-
ible residue. A mild solution of dish washing type soap and water will also work. Do not use
abrasive cleansers, as they can irreparably damage the gold plating on the optical bench.
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4 Use a swab and carefully swab the gold-plated concave surface of the source housing, if neces-
sary.

 

Optical  

Path Swab

Reflector 

Swab

If you need to clean out the hose barbs or replace the tubing connected to the source and
detector housings, use a small pair of diagonal cutters to remove the tubing from the hose barbs.
Use the cutters to pinch the tubing parallel to the hose barb axis, and then pivot the cutters over
the hose barb tip; the tubing will pull off of the hose barb. Be very careful not to cut the tubing
or scratch the hose barb with the cutters, as subsequent tubing connections may leak if the hose
barb is damaged.

5 Let the optical bench dry.

6 Re-assemble the bench, making sure the O-rings are in place on both ends of the bench.
Note that the orientation of the cylinder is not important; either end can be inserted into the
source or detector housing.

7 Re-assemble the LI-840A case.
Make sure that the foam insulation on the inside top cover is positioned over the optical bench;
it is required for thermal stability.

8 Perform zero, span, and secondary span calibrations as described in Calibration Window - Set-
ting the Zero and Span on page 3-23.
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Changing the Fuse
The LI-840A power supply is protected by a 2A 250V, 5 × 20 mm fast-blow type fuse located
inside the case. If the battery fails to power the LI-840A, and will not light the Power LED on
the top panel, check to see if the fuse has blown.

To check the fuse, remove the six screws on the top of the LI-840A. The fuse is located on the
main circuit board, near the Flow In port, as shown below. Replacement fuses (part #439-03952,
in the spares kit) plug into the fuse holder; no soldering is required. Replace the fuse and reas-
semble the LI-840A case.
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Note on Infrared Source Replacement
The infrared source in the LI-840A is rated for more than 18,000 hours of life. Should the source
fail, a replacement can be obtained from LI-COR Biosciences. The source can be replaced in the
field; however, it should be noted that changing a source has the potential of degrading the
accuracy specification for CO2 to as much as 3% of reading. The H2O channel should remain
within the published specification.

If the source fails, the instrument can be returned to LI-COR Biosciences for replacement and
factory recalibration. This will ensure that the accuracy stays within the factory specifications.
Alternatively, if you have two span gasses, you can adjust the calibration yourself. See Two Point
Span (Span 2 Tab) on page 3-26.
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Storing the LI-840A
The LI-840A can be stored in non-condensing conditions, but if it is exposed to high humidity
or moderate humidity for a long period of time while it is powered off, the humidity can tem-
porarily affect measurements. You can identify this issue by observing unexpected drift that sta-
bilizes after several days of operation, an offset in measurements, or unresponsiveness. If your
instrument exhibits these characteristics, verify the issue by comparing raw detector outputs in
data that was collected before and after storage. If you don't have these data, contact LI-COR and
we will provide the calibration data set for your instrument. In the PC interface software, click
View > Diagnostics and observe the values for Raw CO2 Reference and Raw H2O Reference. If
these values are lower than the original values, power on the instrument and let it run (with the
heaters on) for several hours to several days. If the instrument has not fully recovered after sev-
eral days, you may need to disassemble the optical bench and heat the detector in an oven at 65
°C (150 °F) for several hours. Reassemble the instrument and check the measurements.
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Appendix A. Specifications

CO2
Measurement Range: 0-20,000 ppm
Accuracy: Better than 1.5% of reading
Calibration Drift

Zero Drift: <0.15 ppm/°C

Span Drift: < 0.03 %/°C

Total Drift at 370 ppm: <0.4 ppm/°C
RMS Noise at 370 ppm with 1 sec signal filtering: <1 ppm
Sensitivity to water vapor: < 0.1 ppm CO2/mmol/mol H2O

H2O
Measurement Range: 0-60 mmol/mol
Accuracy: Better than 1.5% of reading
Calibration Drift

Drift1 at 0 mmol/mol: <0.003 mmol/mol/°C
1Zero drift is the change with temperature at 0 concentration.
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Span Drift1 at 10 mmol/mol: <0.03 %/°C

Total Drift2 at 10 mmol/mol: <0.009 mmol/mol/°C
RMS Noise at 10 mmol/mol with 1 sec signal filtering: <0.01 mmol/mol
Sensitivity to CO2: <0.0001 mmol/mol H2O/ppm CO2
Measurement Principle: Non-Dispersive Infrared
Traceability: Traceable gases to WMO standards for CO2. NIST traceable LI-610 Portable Dew Point Generator

for H2O
Pressure Compensation Range: 15 kPa-115 kPa
Maximum Gas Flow Rate: 1 liter/min
Output Signals: Two analog voltage (0-2.5V or 0-5V) and two current (4-20mA)
Digital: TTL (0-5V) or Open Collector
DAC Resolution: 14-bits across user-specified range
Source Life: ~18,000 Hours
Power Requirements: Input Voltage 12-30 VDC

1.2A @ 12V (14W) maximum during warm-up with heaters on

0.3A @ 12V (3.6W) average after warm-up with heaters on
Operating Temperature Range: –20°C to +45°C
Relative Humidity Range: 0 to 95% RH, Non-Condensing
Dimensions: 8.75" × 6" × 3" (22.23 × 15.25 × 7.62 cm)
Weight: 2.2 lbs (1 kg)
Internal Optical Cell Volume: 14.5 mL

1Span drift is the residual error after re-zeroing following a temperature change.
2Total drift is the change with temperature without re-zeroing or re-spanning.
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Appendix B. Equation Summary

The LI-840A computes CO2 and H2O concentrations using an equation of the form

B-1

where c is concentration, f() is the calibration function, α is the absorptance, g (α ,P) is the pres-
sure correction, S(α) is the span, and T is the temperature (°C) of the gas in the cell, typically
51.5 °C. Absorptance is computed from

B-2

where V and Vo are the raw detector sample and reference readings, and Z is the zeroing para-
meter.

Span is a linear function of absorptance.

B-3
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H2O Equations

Absorptance αw for water vapor is computed from

B-4

where Vw and Vwo are the sample and reference raw detector readings and Zw is the zero para-
meter. The pressure correction for water vapor is an empirical function gw() of absorptance and
pressure P:

B-5

The value of Po is 99 kPa. When the pressure correction is not enabled, gw() is simply 1.0. Values
for gw() can be viewed on the diagnostics window (see Operation on page 3-1).

Water vapor concentration W (mmol mol-1) is computed from

B-6

where fw(x) is a third order polynomial whose coefficients are given on the calibration sheet.

B-7
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CO2 Equations

The measurement of CO2 is a bit more complicated than for H2O because of the influence of
water vapor. There is a slight direct cross sensitivity in the CO2 signal to H2O. This is measured
at the factory and accounted for in the computation of absorptance (equation B-8). There is also
a band broadening effect that is accounted for in the computation of concentration (equation B-
12).

CO2 absorptance αc is computed from

B-8

where Vc and Vco are the raw detector signals for sample and reference, Zc is the CO2 zero para-
meter, and Xwc is a cross sensitivity parameter for the effect of water vapor on CO2. Its value is
reported on the calibration sheet as “XS=”.

The empirical pressure correction function gc() depends on CO2 absorptance and pressure:

When P = Po, gc() = 1.

When P < Po
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B-9

where a = 1.10158, b = -6.1217 * 10-3, c = -0.266278, d = 3.69895, and z is the asymptotic value of
absorptance, obtained from the calibration coefficients (equation B-13).

B-10

When P > Po

B-11

where X, A, and B are computed as in equation B-9. The variable gc() is viewable on the dia-
gnostics window (see Operation on page 3-1).

CO2 concentration C (µmol mol-1) is computed from
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B-12

where fc(x) is a function whose inverse is a double rectangular hyperbola, and whose coefficients
(a1…a4) are given on the calibration sheet.

B-13

Solving equation B-13 for C yields the calibration function

B-14

Where

B-15

ψ (W) accounts for band broadening by water vapor, and is viewable on the Diagnostic window.

B-16
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The band broadening coefficient h(αc) has been determined to be 1.45 for the LI-840A for CO2
concentrations near ambient. At higher concentrations, the value decreases. We capture this
behavior with an empirical relationship (equation B-17).

B-17

Where z is from equation B-10, and bw is the low concentration band broadening coefficient:
1.45.  This is the value shown on the calibration sheet as BB=1.45.  The present value of h(αc) is
viewable on the Diagnostics screen (Section 3). The typical relationship between h(αc) and CO2
concentration is illustrated below. (‘Typical’ because the exact relationship depends on the rela-
tionship between absorptance and CO2, which is the calibration curve.)
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Implementation Note: We formulated B-17 with 0.64bw – 0.64 instead of the simple equivalent
(0.29) because this allows band broadening corrections to be turned off by setting bw to 1. When
bw =1, h(αc) = 1 everywhere. Also, to avoid computational problems (underflows, overflows, and
division by zero) we constrain the argument αc when computing h(αc) to be

B-18

is typically equivalent to about 600 ppm.
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Calibration Equations

Zeroing H2O

When the command for zeroing water is received, the LI-840A computes the water zero from
equation B-19, where and are averaged for 5 seconds.

B-19

Zeroing CO2
When the command for zeroing CO2 is received, the LI-840A computes the CO2 zero term from
equation B-20, where , , , and are averaged for 5 seconds.

B-20

Spanning H2O

When the command for setting the span for H2O is received, along with the target con-
centration WT, the LI-840A computes Sw0 from equation B-21 , where is averaged over five
seconds.
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B-21

where

B-22

The instrument retains the following values, which are used for subsequent secondary spans:

B-23

B-24

Secondary Span H2O

When the secondary span command for H2O is received, the instrument computes new values
for both Sw0and Sw1. First, it measures a new and computes a new from equation B-22.

Then, it uses these plus the retained values ( and from the previous normal span) to com-

pute

B-25

Given the new span slope Sw1, update the span offset Sw0 by equation B-21.
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Spanning CO2
When the command for setting the span for CO2 is received, along with the target concentration
CT, the LI-840A computes Sc0 from equation B-26, where and are averaged for 5 seconds.

B-26

where

B-27

Note that

B-28

The instrument retains the following values which are used for subsequent secondary spans, if
necessary:
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B-29

B-30

Secondary Span CO2
When the secondary span command for CO2 is received, the instrument computes new values
for both Sc0 and Sc1. First, it measures a new and computes a new β c from equation B-27.
Then it uses these, plus the retained values (αc1 and β c1 from the previous normal span) to com-
pute

B-31

Given the new span slope Sc1, update the span offset Sc0 by equation B-26.

Symbol Summary
Many of the quantities described in the above section are available from the LI-840A. These are
summarized in Table B-1 below.

Symbol XML Tag: <LI840>+ Description
αw <data><h2oabs> H2O absorptance

Table B-1. Symbol summary
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Symbol XML Tag: <LI840>+ Description
gW
(αw,P)

<AUXdata><pHA> Pressure corrected absorptance of H2O

W <data><h2o> H2O (mmol mol-1)
P <data><cellpress> Pressure (kPa)
T <data><celltemp> Temp (C)
αc <data><co2abs CO2 absorptance
gc(αc,P) <AUXdata><pcA> Pressure corrected absorptance of CO2
C <data><co2> CO2 (µmol mol-1)
Vw <data><raw><h2o>  Raw detector readings
Vwo <data><raw><h2oref>
Vc <data><raw><co2>
Vco <data><raw><co2ref>
aw1...aw3 <poly><h2o> Calibration coefficients
ac1...ac4 <poly><co2> Calibration coefficients
Zw <cal><h2okzero>
Sw0 <cal><h2okspan>
Sw1 <cal><h2okspan2>

Table B-1. Symbol summary (...continued)
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Symbol XML Tag: <LI840>+ Description
Zc <cal><co2kzero> Zero and Span values
Sc0 <cal><co2kspan>
Sc1 <cal><co2kspan2>
xwc <poly><xs> Cross sensitivity coefficient
bw <poly><bb> Band broadening coefficient for low CO2
h(αc) <AUXdata><bb_EFF> Computed band broadening coeff for the current

absorptance
ѱ(W) <AUXdata><psi> Band broadening correction factor for water vapor

Table B-1. Symbol summary (...continued)
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Appendix C. Pin Assignments

The figure below indicates pin assignments for the DB-9 connector.

  

1

6

2

3

8

7

4

9

5

Data (RXD)

Data (TXD)

Signal Ground (SG)
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Appendix D. Suppliers

Although the LI-840A has no internal chemicals to replace, the following suppliers may be use-
ful for obtaining chemicals for generating a chemical zero gas.  The company names, addresses,
and phone numbers are the most current we have at the time of this printing.  In some cases the
information may change without notice.

Soda Lime (6-12 mesh) and Magnesium Perchlorate (Anhydrous) Mg(ClO4)2

GFS Chemicals
www.gfschemicals.com Soda Lime: Part #66352
P.O. Box 245 Mg(ClO4)2: Part #49001 (500g, <8% water)
Powell, OH  43065
Phone: 614-881-5501
FAX: 614-881-5989
Toll free: 800-858-9682
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Fisher Scientific
www.fishersci.com
711 Forbes Avenue Soda Lime: Part #S201-212
Pittsburgh, PA  15219-4785 (LI-COR Part #9960-071) 
Phone: 201-467-6400 Mg(ClO4)2: Part #M54-500 (500g)
FAX: 201-379-7415
Toll free: 800-776-7000
Toll free FAX: 800-926-1166

Thomas Scientific
www.thomassci.com
P.O. Box 99 Soda Lime: Part #C703-B76
Swedesboro, NJ  08085-6099 Mg(ClO4)2: Part #C260-M61 (Dehydrite, 500g)
Phone: 609-467-2000
FAX: 609-467-3087
Toll free: 800-345-2100
Toll free FAX: 800-345-5232
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Ascarite II

GFS Chemicals Thomas Scientific
www.gfschemicals.com www.thomassci.com
P.O. Box 245 P.O. Box 99
Powell, OH  3065 Swedesboro, NJ  08085-6099
Phone: 614-881-5501 Phone: 609-467-2000
FAX: 614-881-5989 FAX: 609-467-3087
Toll free: 800-858-9682 Toll free: 800-345-2100

Toll free FAX: 800-345-5232
P.W. Perkins Co., Inc. Fisher Scientific
www.pwperkins.com www.fishersci.com
856-769-3525 711Forbes Avenue

Pittsburgh, PA  15219-4785
Phone: 201-467-6400
FAX: 201-379-7415
Toll free: 800-776-7000
Toll free FAX: 800-926-1166
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Electronic Relay Switches

Crydom Inc. Potter & Brumfield Products Div.
9525 Chesapeake Dr. Siemens Electromechanical Components, Inc.
San Diego, CA  92123 200 S. Richland Creek Dr.
800-827-9366 Princeton, IN 47671-0001
FAX: 619-715-7280 info@ae.sec.siemens.com
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Appendix E. Configuration Grammar

Introduction
The LI-840A communicates exclusively through a serial interface. The following discussion
describes how to implement a synchronized communication protocol.

LI-840A Communications and XML
The configuration grammar used to communicate with the LI-840A is based upon a subset of
the eXtensible Markup Language (XML).  XML relies on the use of tags to "Markup", or give
structural rules to a set of data.

A tag is a descriptive identifier, enclosed between a less than (<) and a greater than (>) symbol,
used in part to describe a piece of data.  For example, <NAME> is a tag that describes a person's
name.  Each tag must have a corresponding end tag, denoted by '/'.  Extending the example
above, the end tag of <NAME> is </NAME>.

Elements are the basic unit of XML content.  An element consists of a start tag and an end tag,
and everything in between.  For example, consider the following element:
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<NAME>George</NAME>.

In this example, <NAME> (start tag) and </NAME> (end tag) comprise the markup, and "George"
comprises the data.  Because XML is extensible, tags can be defined specifically for the data they
are meant to describe.

Elements can also contain other elements other than data.
<NAME>
<FIRST>George</FIRST>
<LAST>Smith</LAST>
</NAME>

In this example, the outermost element <NAME> encompasses two other elements that contain
data.  All elements combined make up the XML document.

Connecting and Configuring Data Output
The LI-840A communicates through a serial port on the front of the instrument.  This port is
configured as follows:

l Baud Rate: 9600 bps
l Data Bits: 8
l Parity: None
l Stop Bits: 1
l Flow Control: None

Appendix E

Appendix E. Configuration Grammar E-2



After a serial connection is established, the LI-840A will immediately send data out the serial
port in the manner in which it was configured previously.  In order to reconfigure the LI-840A
to output specific data values, you must send the RS-232 portion of the XML grammar to the
instrument with the desired values "turned on".  To "turn on" the data value, set the value of the
element to TRUE.  As an example, the following string is sent to the instrument after a con-
nection has been made between the computer (using the Windows® application software) and
the LI-840A:

<LI840>
<CFG>
<OUTRATE>1</OUTRATE>
</CFG>
<RS232>
<STRIP>FALSE</STRIP>
<ECHO>FALSE</ECHO>
<CELL TEMP>TRUE</CELL TEMP>
<CO2>TRUE</CO2>
<CO2ABS>FALSE</CO2ABS>
<CELLPRES>TRUE</CELLPRES>
<IVOLT>TRUE</IVOLT>
</RS232>
</LI840>
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Sending Data to the LI-840A
To send data to the LI-840A, each string must end with a '\n' to ensure that the LI-840A can
parse consecutive commands.

After data have been sent to the LI-840A, the instrument replies with:
<LI840><ACK>TRUE</ACK></LI840>

if the XML was received and parsed correctly.  If there was an error in the XML, the following is
sent:

<LI840><ACK>FALSE</ACK></LI840>.

For example, suppose that you would like to reconfigure the LI-840A to stop outputting cell
temperature.  Here is the command to send to the LI-840A:

<LI840><RS232><CELLTEMP>FALSE</CELLTEMP></RS232></LI840>

If the command was received correctly, the LI-840A replies with
<LI840><ACK>TRUE</ACK></LI840>.

Reading Data From the LI-840A
The LI-840A can send data continuously.  To determine where one message ends and the next
begins, each XML document sent from the LI-840A is delimited with a '\n' (0x10) character.
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Polling the Current State of the LI-840A
The LI-840A can be polled for individual sets of data by sending an XML document with a '?' in
place of the set of elements requested.  The element sets that can be requested include the data
set, the current configuration, and the entire state of the instrument.

Sending this command:
<LI840><DATA>?</DATA></LI840>

instructs the LI-840A to send the most recent set of data values (as configured) as an XML doc-
ument.

Sending this command:
<LI840><CFG>?</CFG></LI840>

instructs the LI-840A to send an XML document containing all of the configuration inform-
ation, including heater status, filter settings, DACs, and alarms.

To receive the entire state of the instrument as an XML document, send this command:
<LI840>?</LI840>.

Calibration
The LI-840A CO2 calibration (zero and span) can be performed using XML grammar.  This is
accomplished in three steps:
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1 Send the calibration command to the LI-840A.

<LI840>
<CAL>
<DATE>{iso date}</DATE>
<CO2SPAN>{int}</CO2SPAN>
<CO2SPAN2>{int}</CO2SPAN2>
<CO2KZERO>{bool}</CO2KZERO>
<co2kspan>{float}</co2Kspan>
<co2kspan2>{float}</co2Kspan2>
</CAL>
</LI840>

2 An acknowledgement is returned from the LI-840A if the commandwas accepted.

<LI840><ACK>TRUE</ACK></LI840>

3 After a few seconds, all of the calibration information is returned from the LI-840A, indicating
that it has finished the zero and/or span.

<LI840>
<CAL>
<CO2LASTZERO>{iso date}</CO2LASTZERO>
<CO2KZERO>{float}</CO2KZERO>
<CO2LASTSPAN>{iso date}</CO2LASTSPAN>
<CO2LASTSPAN2>{iso date}</CO2LASTSPAN2>
<CO2KSPAN>{float}</CO2KSPAN>
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<CO2KSPAN2>{float}</CO2KSPAN2>
</CAL>
</LI840>

If the calibration cannot be performed, an ERROR is sent:
<LI840><ERROR>{Error Text}</ERROR></LI840>.

To Zero the LI-840A

1 Send the XML command to initiate the zero.

<LI840>
<CAL>

<DATE>YYYY-MM-DD</DATE>
<CO2ZERO>TRUE</CO2ZERO>

</CAL>
</LI840>

2 Wait for the acknowledgment.

3 Wait for the date to be returned to verify the zero operation succeeded.  If the operation fails an
<ERROR>will be sent.
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To Span the LI-840A

1 Send the XML command to initiate the span.

<LI840>
<CAL>

<DATE>YYYY-MM-DD</DATE>
<CO2SPAN>Gas Concentration</CO2SPAN>

</CAL>
</LI840>

2 Wait for the acknowledgement.

3 Wait for the date to be returned to verify the span operation succeeded.  If the operation fails an
<ERROR> will be sent.

To Perform a Two Point Span

1 Send the XML command to initiate the first span.

<LI840>
<CAL>

<DATE>YYYY-MM-DD</DATE>
<CO2SPAN>Gas Concentration</CO2SPAN>

</CAL>
</LI840>
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2 Wait for the acknowledgement.

3 Wait for the date to be returned to verify the span operation succeeded.  If the operation fails an
<ERROR>will be sent.

4 Send the XML command to initiate the second span.

<LI840>
<CAL>

<DATE>YYYY-MM-DD</DATE>
<CO2SPAN2>Gas Concentration</CO2SPAN2>

</CAL>
</LI840>

5 Wait for the acknowledgment.

6 Wait for the date to be returned to verify the span operation succeeded.  If the operation fails an
<ERROR>will be sent.

LI-840A XML Grammar and Element Description

Data Types in the XML Grammar
{val | val |...}

The value will be a member of the specified set.  | = or.
{bool}
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Boolean values, TRUE | FALSE.
{float}

Floating point values in decimal or exponential notation.
{int}

Integers.
{iso date}

A date in the ISO format.  4 digit year - 2 digit month - 2 digit day.
Example: 2002-04-27.

XML Grammar
<LI840>

<ACK>{bool}</ACK>
<VER>{string}</VER>

<DATA>
<CELLTEMP>{float}</CELLTEMP>
<CELLPRES>{float}</CELLPRES>
<CO2>{float}</CO2>
<CO2ABS>{float}</CO2ABS>
<H2O>{float}</H2O>
<H2OABS>{float}</H2OABS>
<H2ODEWPOINT>{float}</H2ODEWPOINT>
<IVOLT>{float}</IVOLT>
<RAW>

<CO2>{int}</CO2>

Appendix E

Appendix E. Configuration Grammar E-10



<CO2REF>{int}</CO2REF>
<H2O>{int}</H2O>
<H2OREF>{int}</H2OREF>

</RAW>
</DATA>

<AUXDATA>
<PCA>{float}</PCA>
<PHA>{float}</PHA>
<BB_EFF>{float}</BB_EFF>
<PSI>{float}</PSI>

</AUXDATA>
<RS232>

<CO2>{bool}</CO2>
<H2O>{float}</H2O>
<CELLTEMP>{bool}</CELLTEMP>
<CELLPRES>{bool}</CELLPRES>
<IVOLT>{bool}</IVOLT>
<CO2ABS>{bool}</CO2ABS>
<H2OABS>{bool}</H2OABS>
<H2ODEWPOINT>{bool}</H2ODEWPOINT>
<RAW>

<CO2>{bool}</CO2>
<CO2REF>{bool}</CO2REF>
<H2O>{bool}</H2O>
<H2OREF>{bool}</H2OREF>

</RAW>
<ECHO>{bool}</ECHO>
<STRIP>{bool}</STRIP>

</RS232>
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<CFG>
<HEATER>{bool}</HEATER>
<PCOMP>{bool}</PCOMP>
<FILTER>{int}</FILTER>
<OUTRATE>{float}</OUTRATE>
<ALARMS>

<SOURCE>H2O | CO2<SOURCE>
<ENABLED>{bool}</ENABLED>
<HIGH>{float}</HIGH>
<HDEAD>{float}</HDEAD>
<LOW>{float}</LOW>
<LDEAD>{float}</LDEAD>

</ALARMS>
<BENCH>{5|14}</BENCH>
<SPAN>{int}</SPAN>
<DACS>

<RANGE>{2.5|5.0}</RANGE>
<SET1>{float}</SET1>
<SET2>{float}</SET2>
<D1>{NONE|CO2|H2O|H2ODP|CELLTEMP|CELLPRES}</D1>
<D1_0>{float}</D1_0>
<D1_F>{float}</D1_F>
<D2>{NONE|CO2|H2O|H2ODP|CELLTEMP|CELLPRES}</D2>
<D2_0>{float}</D2_0>
<D2_0>{float}</D2_F>

</DACS>
</CFG>
<CAL>

<DATE>{serial number and iso date}</DATE>

Appendix E

Appendix E. Configuration Grammar E-12



<CO2ZERO>{bool}</CO2ZERO>
<CO2SPAN>{int}</CO2SPAN>
<co2span2>{int}</co2span2>
<H2OZERO>{bool}</H2OZERO>
<H2OSPAN>{int}</H2OSPAN>
<H2OSPAN2>{int}</H2OSPAN2>
<CO2KZERO>{float}</CO2KZERO>
<CO2KSPAN>{float}</CO2KSPAN>
<co2kspan2>{float}</co2span2>
<H2OZERO>{float}</H2OZERO>
<H2OKSPAN>{float}</H2OKSPAN>
<h2okspan2>{float}</h2ospan2>

or

<CO2LASTZERO>{iso date}</CO2LASTZERO>
<CO2LASTSPAN>{iso date}</CO2LASTSPAN>
<H2OLASTZERO>{iso date}</H2OLASTZERO>
<H2OLASTSPAN>{iso date}</H2OLASTSPAN>

</CAL>
<POLY>

<DATE>{string}</DATE>
<BB>{float}</BB>
<XS>{float}</XS>
<RESET>{bool}</RESET>
<CO2>

<A1>{float}</A1>
<A2>{float}</A2>
<A3>{float}</A3>
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<A4>{float}</A4>
</CO2>
<H2O>

<A1>{float}</A1>
<A2>{float}</A2>
<A3>{float}</A3>

</H2O>
<PRESS>

<A0>{float}</A0>
<A1>{float}</A1>

</PRESS>
</POLY>
<ERROR>{string}</ERROR>

</LI840>
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Element Descriptions

Tag Parent Value(s) R/W Comments

<LI840> N/A (root) <ACK>
<VER>
<ERROR>
<DATA>
<AUXDATA>
<RS232>
<CFG>
<CAL>
<POLY>
?

<LI840> is the root tag for all XML statements. 
A ? outputs the entire XML document.

Examples:
<LI840>?</LI840>
<LI840><ACK>TRUE</ACK></LI840>
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Tag Parent Value(s) R/W Comments

<DATA> <LI840> <CO2>
<CO2ABS>
<H2O>
<H2ODEWPOINT>
<H2OABS>
<CELLTEMP>
<CELLPRES>
<IVOLT>
<RAW>
?

<DATA> contains all data values sent from
the LI-840A.  All of the elements within the
DATA tag are readable only.  A ? requests all
data values to be output.

Examples:
<LI840><DATA><CO2>2.34e2</CO2><IVOLT>1.5e2</IVOLT></DATA></LI840>
<LI840><DATA>?</DATA></LI840>
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Tag Parent Value(s) R/W Comments

<CO2> <DATA> Float R CO2 in ppm
<CO2ABS> <DATA> Float R CO2 absorption
<H2O> <DATA> Float R H2O in mmol/mol
<H2ODEWPOINT> <DATA> Float R H2O in °C
<H2OABS> <DATA> Float R H2O absorption
<CELLTEMP> <DATA> Float R Cell temperature
<CELLPRES> <DATA> Float R Cell pressure
<IVOLT> <DATA> Float R Input voltage
<RAW> <DATA> <CO2> Raw detector readings

<CO2REF>
<H2O>
<H2OREF>

Examples:
<LI840><DATA><CELLTEMP>5.16E1</CELLTEMP><CELLPRES>9.742E1</CELLPRES>
<CO2>6.17E2</CO2><CO2ABS>8.94E2</CO2ABS>DATA></LI840>

Appendix E

Appendix E. Configuration Grammar  E-17



Tag Parent Value(s) R/W Comments

<CO2> <RAW> Integer R
<CO2REF> <RAW> Integer R
<H2O> <RAW> Integer R
<H2OREF> <RAW> Integer R

Tag Parent Value(s) R/W Comments

<AUXDATA> <LI840> ? <AUXDATA> contains all auxiliary data values
that can be retrieved from the LI-840A. All of the
elements witin the AUXDATA tag are readable
only. A ? requests all data values to be output.
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Tag Parent Value(s) R/W Comments

<PCA> <AUXDATA> Float R
<PHA> <AUXDATA> Float R
<PSI> <AUXDATA> Float R
<BB_EFF> <AUXDATA> Float R

Tag Parent Value(s) R/W Comments

<RS232> <LI840> <CO2>
<CO2ABS>
<H2O><H2ODEWPOINT>
<H2OABS>
<CELLTEMP>
<CELLPRES>
<IVOLT>
<RAW>
<ECHO>
<STRIP>

Setting <RS232> values will determine
what values are output in <DATA>
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Tag Parent Value(s) R/W Comments

<CO2> <RS232> TRUE | FALSE R/W CO2 in ppm
<CO2ABS> <RS232> TRUE | FALSE R/W CO2 absorption
<H2O> <RS232> TRUE | FALSE R/W H2O in mmol/mol
<H2ODEWPOINT> <RS232> TRUE | FALSE R/W H2O dew point
<H2OABS> <RS232> TRUE | FALSE R/W H2O absorption
<CELLTEMP> <RS232> TRUE | FALSE R/W Cell temperature
<CELLPRES> <RS232> TRUE | FALSE R/W Cell pressure
<IVOLT> <RS232> TRUE | FALSE R/W Input voltage
<RAW> <RS232> <CO2> Raw detector readings

<CO2REF>
<H2O>
<H2OREF>

<ECHO> <RS232> TRUE | FALSE R/W Echo commands sent to LI-840
<STRIP> <RS232> TRUE | FALSE R/W Strip XML from all data sent

Example:
<LI840><CFG><OUTRATE>0.5</OUTRATE></CFG><RS232><STRIP>FALSE</STRIP>
<ECHO>FALSE</ECHO><CELLTEMP>TRUE</CELLTEMP><CO2ABS>TRUE</CO2ABS>
<CO2>TRUE</CO2><CELLPRES>TRUE</CELLPRES><IVOLT>TRUE</IVOLT><RAW>TRUE
</RAW></RS232></LI840>
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Tag Parent Value(s) R/W Comments

<CO2> <RAW> Integer R
<CO2REF> <RAW> Integer R
<H2O> <RAW> Integer R
<H2OREF> <RAW> Integer R
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Tag Parent Value(s) R/W Comments

<CFG> <LI840> <OUTRATE>
<HEATER>
<PCOMP>
<DOFFSET>
<FILTER>
<ALARMS>
<DACS>
<BENCH>
<SPAN>
?

Elements within the <CFG> tag control system set-
tings.

Example:
<LI840><CFG><HEATER>TRUE</HEATER><PCOMP>TRUE</PCOMP></CFG></LI840>
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Tag Parent Value(s) R/W Comments

<OUTRATE> <CFG> 0.5 to 20 R/W Output data every N seconds (0.5 s increments).
<HEATER> <CFG> TRUE | FALSE R/W Turn heater on/off.
<PCOMP> <CFG> TRUE | FALSE R/W Pressure compensation on/off.
<FILTER> <CFG> 0 to 20 R/W Set a 0 to 20 second filter.
<ALARMS> <CFG> <SOURCE>

<ENABLED>
<HIGH>
<HDEAD>
<LOW>
<LDEAD>

High and low alarm settings.

<DACS> <CFG> <RANGE>
<SET1>
<SET2>
<D1>
<D1_0>
<D1_F>
<D2>
<D2_0>
<D2_F>

DAC outputs.

<BENCH> <CFG> 14 R Optical bench length (cm).
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Tag Parent Value(s) R/W Comments

<ENABLED> <ALARMS> TRUE | FALSE R/W Enable alarms.
<SOURCE> <ALARMS> CO2 | H2O R/W Channel (CO2:ppm, H2O:mmol/mol)
<HIGH> <ALARMS> Float R/W High alarm on at this value.
<HDEAD> <ALARMS> Float R/W High alarm off at this value.
<LOW> <ALARMS> Float R/W Low alarm on at this value.
<LDEAD> Float R/W Low alarm off at this value.

Example:
<LI840><CFG><ALARMS><ENABLED>TRUE</ENABLED><SOURCE>H2O</SOURCE>
<HIGH>1600</HIGH><HDEAD>1500</HDEAD><LOW>200</LOW><LDEAD>300</LDEAD>
</ALARMS></CFG></LI840>
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Tag Parent Value(s) R/W Comments

<RANGE> <DACS> 2.5 | 5.0 R/W Output voltage.  2.5V or 5.0V.
<SET1> <DACS> Float R/W Set DAC output to value (DACS

must be NONE)
<SET2> <DACS> Float R/W Set DAC output to value (DACS

must be NONE)
<D1> <DACS> CO2 | H2O |

H2ODEWPOINT |
CELLPRES |
CELLTEMP | NONE

R/W DAC1

<D1_0> <DACS> Float R/W Value where DAC1 outputs 0V
<D1_F> <DACS> Float R/W Value where DAC1 outputs full

scale
<D2> <DACS> CO2 | H2O |

H2ODEWPOINT |
CELLPRES |
CELLTEMP | NONE

R/W DAC2

<D2_0> <DACS> Float R/W Value where DAC2 outputs 0V
<D2_F> <DACS> Float R/W Value where DAC2 outputs full

scale

Example:
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<LI840><CFG><DACS><RANGE>2.5</RANGE><D1>CO2</D1><D2>CELLTEMP</D2></DACS>
</CFG></LI840>
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Tag Parent Value(s) R/W Comments

<CAL> <LI840> <DATE>
<H2OZERO>
<H2OSPAN>
<H2OSPAN2>
<H2OLASTZERO>
<H2OLASTSPAN>
<H2OLASTSPAN2>
<H2OKZERO>
<H2OKSPAN>
<H2OKSPAN2>
<CO2ZERO>
<CO2SPAN>
<CO2SPAN2>
<CO2LASTZERO>
<CO2LASTSPAN>
<CO2LASTSPAN2>
<CO2KZERO>
<CO2KSPAN>
<CO2KSPAN2>
<POLY>

Calibration parameters.  When calibrating,
<DATE> must be paired with a <CO2ZERO>
or a <CO2SPAN>, or a <H2OZERO> or
<H2OSPAN>.
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Tag Parent Value(s) R/W Comments

<DATE> <CAL> 20 character
date

W The date the calibration is taking place.

<H2OZERO> <CAL> TRUE |
FALSE

W Start H2O zero.

<H2OSPAN> <CAL> Float (H2O
°C)

W Start the first H2O span.

<H2OSPAN2> <CAL> Float (H2O
°C)

W Start the second H2O span.

<H2OLASTZERO> <CAL> 20 character
date

R Date the LI-840A was last zeroed.

<H2OLASTSPAN> <CAL> 20 character
date

R Date the LI-840A was last spanned.

<H2OKZERO> <CAL> Float R/W Calibration constant.
<H2OKSPAN> <CAL> Float R/W Calibration constant.
<H2OKSPAN2> <CAL> Float R/W Calibration constant.
<CO2ZERO> <CAL> TRUE |

FALSE
W Start a CO2 zero.

<CO2SPAN> <CAL> Float (CO2
ppm)

W Start the first CO2 span.
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Tag Parent Value(s) R/W Comments

<CO2SPAN2> <CAL> Float (CO2
ppm)

W Start the second CO2 span.

<CO2LASTZERO> <CAL> 20 character
date

R The date the LI-840A was last zeroed.

<CO2LASTSPAN> <CAL> 20 character
date

R The date the LI-840A was last spanned.

<CO2KZERO> <CAL> Float R/W Calibration constant.
<CO2KSPAN> <CAL> Float R/W Calibration constant.
<CO2KSPAN> <CAL> Float R/W Calibration constant.

Tag Parent Value(s) R/W Comments

<POLY> <LI840> <LI840> R/W Serial number and factory calibration date:
HGA_XXXX Day Month Year

<BB> R/W Band broadening.
<XS> R/W Cross sensitivity.
<CO2> R/W CO2 coefficients.
<H2O> R/W H2O coefficients.
<PRESS> R/W Pressure correction coefficients
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Examples:

To Zero:
<LI840><CAL><DATE>2015-02-07</DATE><CO2ZERO>TRUE</CO2ZERO></CAL></LI840>

To Span:
<LI840><CAL><DATE>2015-02-07</DATE><CO2SPAN>1000</CO2SPAN></CAL></LI840>

Possible LI-840 Replies:
<LI840><ACK>TRUE</ACK></LI840>
<LI840><ERROR>{ErrorText}</ERROR></LI840>
<LI840><CAL><CO2LASTSPAN>{isodate}</CO2LASTSPAN><CO2LASTZERO>{isod-
ate}</CO2LASTZERO><CO2KZERO>{float}
</CO2KZERO><CO2KSPAN>{float}</CO2KSPAN></CAL></LI840>

Tag Parent Value(s) R/W Comments

<LI840> <POLY> 20 character date R/W Serial number and factory cal-
ibration date:HGA XXXX Day
Month Year

<BB> <POLY> Float R/W Band broadening value.
<XS> <POLY> Float R/W Cross sensitivity value.
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Tag Parent Value(s) R/W Comments

<CO2> <POLY> <A1><A2><A3><A4> R/W Floating point coefficients for the
CO2 calibration inverse rectangular
hyperbola.

<H2O> <POLY> <A1><A2><A3> R/W Floating point coefficients for the
H2O calibration polynomial.

<PRESS> <POLY> <A0>

<A1>

R/W Floating point coefficient for CO2
pressure correction

Tag Parent Value(s) R/W Comments

<ACK> <LI840> TRUE | FALSE R Acknowledgment to a send command.
<VER> <LI840> Text R Embedded software version.
<ERROR> <LI840> Text R Error.  Includes a message.
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Appendix F. Warranty

Each LI-COR, Inc. instrument is warranted by LI-COR, Inc. to be free from defects in material
and workmanship; however, LI-COR, Inc.'s sole obligation under this warranty shall be to repair
or replace any part of the instrument which LI-COR, Inc.'s examination discloses to have been
defective in material or workmanship without charge and only under the following conditions,
which are:

1 The defects are called to the attention of LI-COR, Inc. in Lincoln, Nebraska, in writingwithin one
year after the shipping date of the instrument.

2 The instrument has not been maintained, repaired or altered by anyone who was not approved
by LI-COR, Inc.

3 The instrument was used in the normal, proper and ordinary manner and has not been abused,
altered, misused, neglected, involved in an accident or damaged by act of God or other casualty.
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4 The purchaser, whether it is a DISTRIBUTOR or direct customer of LI-COR or a DISTRIBUTOR'S
customer, packs and ships or delivers the instrument to LI-COR, Inc. at LI-COR Inc.'s factory in
Lincoln, Nebraska, U.S.A. within 30 days after LI-COR, Inc. has receivedwritten notice of the
defect. Unless other arrangements have been made in writing, transportation to LI-COR, Inc. (by
air unless otherwise authorized by LI-COR, Inc.) is at customer expense.

5 No-charge repair parts may be sent at LI-COR, Inc.'s sole discretion to the purchaser for install-
ation by purchaser.

6 LI-COR, Inc.'s liability is limited to repair or replace any part of the instrument without charge if
LI-COR, Inc.'s examination disclosed that part to have been defective in material or work-
manship.

There are no warranties, express or implied, including but not limited to any implied war-
ranty of merchantability of fitness for a particular purpose on underwater cables or on
expendables such as batteries, lamps, thermocouples, and calibrations.

Other than the obligation of LI-COR, Inc. expressly set forth herein, LI-COR, Inc. disclaims
all warranties of merchantability or fitness for a particular purpose. The foregoing con-
stitutes LI-COR, Inc.'s sole obligation and liability with respect to damages resulting from
the use or performance of the instrument and in no event shall LI-COR, Inc. or its rep-
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resentatives be liable for damages beyond the price paid for the instrument, or for direct,
incidental or consequential damages.

The laws of some locations may not allow the exclusion or limitation on implied warranties or
on incidental or consequential damaged, so the limitations herein may not apply directly. This
warranty gives you specific legal rights, and you may already have other rights which vary from
state to state. All warranties that apply, whether included by this contract or by law, are limited
to the time period of this warranty which is a twelve-month period commencing from the date
the instrument is shipped to a user who is a customer or eighteen months from the date of ship-
ment to LI-COR, Inc.'s authorized distributor, whichever is earlier.

This warranty supersedes all warranties for products purchased prior to June 1, 1984, unless this
warranty is later superseded. To the extent not superseded by the terms of any extended warranty,
the terms and conditions of LI-COR’s Warranty still apply.

DISTRIBUTOR or the DISTRIBUTOR's customers may ship the instruments directly to LI-COR
if they are unable to repair the instrument themselves even though the DISTRIBUTOR has been
approved for making such repairs and has agreed with the customer to make such repairs as
covered by this limited warranty.

Further information concerning this warranty may be obtained by writing or telephoning War-
ranty manager at LI-COR, Inc.
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Measuring Change in a Changing World
®

LI-COR, Inc. • Environmental • 4647 Superior Street • P.O. Box 4425 • Lincoln, Nebraska 68504 USA
Phone: 402-467-3576 • FAX: 402-467-2819

Toll-free 1-800-447-3576 (U.S. & Canada)
envsales@licor.com
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